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Why Use the TriSys Browser Extension

e Compatible with LinkedIn Free and LinkedIn Recruiter

e Streamlined business development and contact management

e Streamlined client and candidate database management

e Enrich your TriSys contact database with Linkedln contact information

e Overlay of key CRM/ATS contact details directly within LinkedIn profile
pages

e Faster and more informed decision-making, less mistakes and greater
accuracy

e Running action workflows directly from within LinkedIn profile pages

e Saving time and money on a daily basis, increasing your operational
returns

The TriSys browser extension works with the latest version of Google Chrome and
has also been successfully tested on Microsoft’s latest Edge web browser which
runs on the Google Chromium open source web browser engine.

Install the Extension

Click here: https://chrome.google.com/webstore/search/trisys

Next, click the blue button “Add to Chrome”

#~ chrome web store £ Signin
trisys. X Extensions 10f 1extensions
« Home
(O Extensions TI’iSyS
O Themes n Offered by: https://recruitment.trisys.co.uk
‘Add to Chrome
Features e Integration with TriSys Recruitment CRM/ATS Database.
O Runs Offiine %% J Kk 11 Productivity
O By Google

Click “Add Extension”

£~ chrome web store Bl Add "Trisys™? & Signin

It can:

Home > Extensions > TriSys Rea

ﬂ TriSys

_— Offered by: https://recruitr|

% %% % 11 | Produc|

The extension will now be installed, this is clear by the presence of the TriSys icon
at the top right:
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X g ChromeWebStore-trisys X = 4 = x

ax omc[u]e:
X

! ﬂ TriSys has been added to Chrome

Use this extension by licking on this icon.

§ Manage your extensions by clicking Extensions in the
Tools menu.

To get your extensicns on all your computers, turn on sync

‘-h available in the

e

chrome web store

Once the Extension is visible, you will need to open any LinkedIn profile page (for

example your own LinkedIn profile page).

Next, click the TriSys icon. You will see the following pop-up window, where you will

click “Connect”

w (@ 0 83

L Trisys
TriSys Add-In

This component allows you to connect any application (e.g. Microsoft Office, LinkedIn,
Google Mail etc..) to TriSys Cloud.

You will thus be able to import e-mails, contact/company/job details directly into TriSys,
as well as lookup contact/company details when viewing incoming e-mails, or pull/lookup
data from a variety of sources directly into this component for your ultimate

convenience.

TriSys is a suite of sophisticated business sofware tools running in a global doud
computing system allowing you access to your data from any device (mobile phone,
tablet, PC, smart speaker), at any time.

Please click the connect button below to submit your credentials, or learn more or sign-
Up to our services.

@ Learn Mare / Sign-Up

Once you click you will need to authenticate using your existing TriSys

username and password.

e For cloud hosted TriSys Customers, this will be your existing TriSys

username and password

e For TriSys Customers with an onsite database server deployment, please
contact your local TriSys database administrator, who will then contact
support@trisys.co.uk requesting that you are authorized to login and use
the TriSys Browser Extension (when this happens you will be provided with a
link to set a password, which you then use in combination with your work e-

mail address)
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7 G ® B B Should you see the message

below, your username/password

Tssadids either does not match our
This component allows you to connect any application (e.g. Microsoft Office, LinkedIn, . .
Google Mail etc..) to TriSys Cloud. records (you can at thIS pOInt
B8 Login = retry or click “Reset Password” or

your user account has not yet
been granted permission to use
the TriSys Browser Extension.

E-Mail
your-work-email@your-company.com
Password

......... i TriSys Add-In 3

ncorrect credentials
Login Reset Password Register Cancel

OK

Visual Functionality Overview
The TriSys browser extension allows you to visit LinkedIn profiles and import
contacts into your TriSys CRM/ATS database.

The extension also allows linking existing TriSys database contacts to their
corresponding Linkedln profile pages, resulting in a fast, informative and very
convenient information-rich overlay when visiting LinkedIn profile pages, as
shown in the example below (the extension is activated by clicking the ® icon on
your web browser toolbar.

If the LinkedIn profile contact is already in your database, the following is the look
and feel of the extension overlay window, next to a LinkedIn contact profile:
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in B

Grow your business - Join thousands of web design agencies worldwide who choose Elementor 4d -

Promoted

O Personal Mobile
Garner Osborn
Circuits | & HomePhone

9 Address

© Website

Learn more Sope
Josie Musto - 1st Opus Laboris Recruitment B CVPreview Y
Recruiter at Opus Laboris Recruitment ¥ University of Cambridge Learn the skills Jd & Requirements 0-

Cambridge, United Kingdom - 57 connections - Contact info

Highlights R B ScheduledTasks o -
(>)  RrE——
‘-\ 5 mutual connections
S A e e Z Niche Recruiting
£ A% (: ) I Viewers: 31,019
sl L

The top section of the browser extension allows you to perform the following
operations, provided that you are running TriSys:

- Open the contact (click the name or use the CRM menu)

- Open the company (if applicable) by clicking the name or use the CRM
menu

- Open social network pages (social network icons)

- Run Actions (Call, Note, Add to Shortlist, ToDo and more)

- You can also selectively update the contact with the most recent LinkedIn
data (CRM Menu)

Note: the range of displayed contact details displayed will vary depending on the

corresponding TriSys database fields having value or no value, hence you may
see more or less contact details.

in B

2 | 6w o

Josie Musto - 1st — s

Recruiter at Opus Laboris Recruitment  Univ ° Learn the skills | » <

Cambridge, United Kingdom - 57 connections - Contact info {

> ° -

e 0-

Highlights v

5 mutual connections by -
PRI Aiign Recruiting with Job
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The original CV file can also be seen, using the “CV Preview” tab:

B GRMY Acionsv @ v

B CVPreview N

Josie Musto

Recruter at Opus Laboris Recruitment

Summary

1am recruite speciaising i gardening.

Experience

You can also view Requirements, Placements, Notes/History and Scheduled Tasks,
together with total entries for each of these.

L Requirements 0-
£ Placements 0-
W Notes/History D -
B Scheduled Tasks m v

Click any of the tabs to expand the contents (for example “Requirements). You
can click the requirement reference/job title and this will open the corresponding
requirement in your TriSys database (you must have TriSys running).

4 Requirements ° a

& SN/Req/000655 : .net Developer
Josie Musto, Wonga

4 JM/Req/000416 : Kitchen Expert
Josie Musto, Wonga

4 JM/Req/000417 : Application Engineer
Josie Musto, Wonga

4 FJ/Req/001097 : Quantity Surveyor
John Adams, ABC Bank

Page 6 of 15



1 o < ilable in tt
trisys oy i

Web Browser Extension o

Add new contact from LinkedlIn

It possible to add brand new contacts to your TriSys database, simply by visiting a
Linkedln profile and adding the contact, a single click operation which saves you
time and money, increases the quality of your TriSys contact database and helps
you generate additional revenue.

When you visit a LinkedIn profile, an automatic check takes place to confirm
whether the LinkedIn profile page is already linked to an existing record on your
TriSys database.

If no link is found to exist, two options are presented:

- Add new Contact
- Assign to Existing Contact

* B 5@

2 15 t i Add v [
Q Search =] L QL sy [ share o &
ome k  Jobs Messaging Nofifications ~ Me v [——— e
lew Contact
Actor | Writer | Director | Producer | Entrepren
W Assign to Existing Contact
i ’

28 Pub
ofyd [ Profile httpsi//www.linkedin.com/in/thejlo
= Work
% Website hitp//jenniferlopez.com
4
. Work
i) Start off W | & Location Los Angeles, California
2 Home
[ Fotow | I [
ore- [ Twicer
Jen nifer Lopez m A Nuyorican Productions Inc Unable to find a matching contact in TriSys
. Use the Add menu to create a new contact record using this
Actor | Writer | Director | Producer | Entrepreneur Learn the skills | profile, or assign this profile to an existing contact record in TriSys
Los Angeles, California - 30,515 followers - Contact info ‘ = i
k@‘ |
|
|
About
I'm a mom, partner, actor, singer, film & television producer, fashion designer, bestselling author, entrepreneur, and @ |
humanitarian. (Say that 3 times fast!) My next project "Second Act” is a funny, charming, comedy and hits theaters |
December 21. | recently completed my directorial debut of the music video for my new song, “Limitless”. I' ... see more Script

Viewers: 1,712

RN A rLinc ith Actare 2.

Normally at this point, it is best practice to click “Assign to Existing Contact” and
then specify a contact name. This will enable you to search your TriSys database
and link an existing contact in your database to the LinkedIn profile you are
currently viewing:
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L Trisys & addv & v 1 Trisys inE & Addv @ v

Jennifer Lopez
Actor | Witer | Director | Producer | Entreprer|

tor | Producer | Entrepreneur

A8 Public Profile a8 P
M Profile hetps:/funw linkedin.comfin/thejlo || @ Profile hupsif i linkedin.com/in/thejle
= Work = 8 Lookup Contact x
% Website Rtto/fjennderlopez.com %
« Work - Lookup all contact records in TriSys which maich this name.
# Location Los Angeles, California " Name Jennifer Lopez
= Home =
B Twitter e
' Search Cancel

Unable to find a matching contact in TriSys
o Use the Add menu to create a new contact record using this

profile, or assign this profile to an existing contact record in TriSys.

If no contact exists in your TriSys database which matches this LinkedIn profile,
you may proceed to clicking “Add New Contact”

1 Trisys & Addy & v

Jennifer Lopez 4 ew lud
Acror | Writer | Director | Producer | Entrepren
Nuvyorican Productions Inc Assign to Existing Contact

This will then allow you to selectively edit the LinkedIn field simply by clicking the
text on the left hand side of the extension, for example under “Job Title”

Actor | Writer | Director | Produce

You can click this text to edit the job title before adding the contact.

Note the presence of the “ icons on the left hand side of the extension, which
allow you to lookup job titles, company names and company addresses which
the imported contact should be linked to.

The chosen ® fields will be imported into the TriSys contact record when you
click the "™ button.
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Jennifer Lopez @
Actor | Writer | Director | Producer | Entrepreneur

Los Angeles, California + 30515 followers + Contact info

About

Once you have added a new record or updated an existing record, your TriSys
database will be automatically updated in real time. This works whether you are
using the TriSys Apex browser CRM system or the TriSys CRM Windows Desktop
application edition

RECRUITMENT SOFTWARE

Associate existing TriSys database record with LinkedIn

profile

It is likely that your TriSys database already has various contacts and that some
of these do not yet have a link to their corresponding LinkedIn profile page. In such
cases you would not want to create a new contact, rather link the existing contact
to a LinkedIn profile.

If you are using TriSys Apex, you can automatically launch a LinkedIn search
which aims to find the corresponding contact. This is done using the “View” button
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in the “Social Networks” tab of a contact record.

RECRUITMENT SOFTWARE

. =

Choose the relevant contact and load their LinkedIn profile page. The browser
extension is designed to work within LinkedIn profile pages, which contain the
relevant contact data.

Note: if you are using the TriSys Windows Desktop Application, you will not have a
“View” button as per above image. In this case, simply type the contact
name/surname in the actual LinkedIn.com search box and then open the LinkedIn
profile you wish to display.

Now that you have a LinkedIn profile displayed, you can link/associate the
LinkedIn profile page to the existing contact in your TriSys database, by clicking
“Assign to Existing Contact”
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(@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Cookie Policy ys @ rdv @ Seuingsv
Richard Branson Add New Contact
0 Founder at Virgin Group

in EEG

Never miss an update - Follow the official Cisco Training and Certification page 4d -+
M Profile httpsi//www.linkedin.com/in/rbranson

& Work

% Website https:/fawvaw virg

L Work

# Location Virgin Islands (British)

Francisco, expl{ @& Home

with B
[ Twicer
[ Unable to find a matching contact in TriSys
- o Use the Add menu to create a new contact record using this
) — profile, or assign this profile to an existing contact record in
Richard Branson - 3rd [ @ Virgin Group . Trisys.
People Also View
Founder at Virgin Group Stowe School
Virgin Islands (British) - 16,213,590 followers - Contact info Barack (
Former B
America
<
About Jess Wh
i)
Former Prayooy-
Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony,
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading Jennifer Lopez m
international investment group and one of the world's most recognised and respected brands. Since startin: ... see more
Actor | Writer | Director | Producer |

Entrepreneur

Next, type the forename and/or surname and Search. You can use either the

forename and/or surname:

(@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Cookie Policy

Richard Branson
ounder ot Virgin Group

Profile hutps://www linkedin.com/in/rbranson

in Q Search

Never miss an update - Follow the official Cisco Training and Certification page 2d -+

@ Lookup Contact x

Lookup all contact records in TriSys which match this name:

Rm Richard Branson

Ready for y

Unfollow [ ‘ Search Cancel

Richard Branson - 3rd @ @ Virgin Group

iSys.
People Also View L
Founder at Virgin Group Stowe School
Virgin Islands (British) - 16,213,590 followers - Contact info Barack
Former
America
<
About % Jess Wh
i |
Former Praywoy

Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony,

travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading Q Jennifer Lopez [

Actor | Writer | Director | Producer |
Entrepreneur

international investment group and one of the world's most recognised and respected brands. Since startin: ... see more

A list of potential matches found in your TriSys database is shown, allowing you to
choose which existing contact record should be linked to the Linkedln profile
page. When a contact is selected (click the contact name) the link is established
between the LinkedIn profile and the TriSys database contact.

Note how, next to each contact found to match the name/surname combination,
you can see:

e The contact type
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e The contact ID (which can be used to easily pinpoint, using your TriSys
database and looking up this ID, whether the contact is the one you wish to
assign the LinkedlIn profile to, thus eliminating any ambiguity in the process
of assigning a LinkedIn profile page to a TriSys database record)

* e =\
@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Cookie Policy L Trisys & Addv @ Sewingsv
Richard Branson
in Q Search [ : (%) nder ot Virgn Group

ching Co

ﬁ Richard Branson-Smythe m
4 Airline cutive

&  Tesing Technologies Corp

Richard BRanson
! 2 Candidate - 50473
Accountant

Richard Branson
ceo e

Francisco, expl{ Virgin Music
wi

[

Like Digital ? - Earn a Digital Certificate Online at Cornell. Register Now! ~d -+

[t (e

i - 3rd @ Virgin Group X
Richard Branson in] People Also View
Founder at Virgin Group | Stowe School
Virgin Islands (British) + 16,213,590 followers - Contact info Barack ¢
Former P
America
~
About . JessWh
)
\ [T ————
Founder of the Virgin Group. which has gone on to grow successful businesses in sectors including mobile telephony.
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading Jennifer Lopez u
international investment group and one of the world's most recognised and respected brands. Since start see more
Actor | Writer | Director | Producer |

Entrepreneur

The browser extension will now display/overlay all the relevant information about
the contact on your TriSys database, directly inside the LinkedIn profile:

* @ HM
1 Tris) PR CRMv Adionsv @ v
Richard Branson
e =
rgin Music mo
A8 Contact Details A
od
& Work E-Mail Ric!
. Work Phone 01280 188205
O Work Mobile 07252244187
O Personal Mobile 07300 572857
See who's vi§ & Home Phone 01823 131160
9 Address The Office Crawley Sussex, London, London, RH10 9NU,
United Kingdom
© Website hitps://wem
Richard B 3d @ VirginG ]
3 @ Virgin Group i
iehar ranson People Also Vie|
Founder at Virgin Group Stowe School
| B cvereview v
Virgin Islands (British) - 16,218,165 followers - Contact info Barack
Former| & Requirements -
Americi
£ Placements 0-

About ot B Notes/Hist v
Actor || i @
Entrepr|

Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony, B Scheduled Tasks v
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading :
international investment group and one of the world's most recognised and respected brands. Since startin: .. see more @ Jeff Weiner - 2

CEO at Linkedin
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You can also run Actions directly from within the extension pop-up:

Note/History
Scheduled Task

Send SMS Text

e To00
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Selective Field Update

You may also selectively update the existing TriSys contact details with those

found on Linkedln:

.
@000

This will reveal a window allowing you to update your TriSys database with
information found on the LinkedIn profile page:

(1] I

o .
© o

@ o,
- o «© -
«© :
« @ .
®@

Note the following key functionalities when updating an existing contact:

- You can edit the values shown on the left (those found on the Linkedln
profile) by clicking the editable text fields on the left

Q,

- You can click the “Search” spyglass icon where this icon is available,
allowing you to link the contact to an existing company within your TriSys
database

- You can selectively enable or disable the copy/update of a specific field by

@ which is ON by default for all fields, allowing

using the switch button
you to turn off specific field updates where an update is not required

- The “Update TriSys” will update the database record with the specific
information you have provided as shown on the left

- Where additional fields exist, a vertical scrollbar will be displayed allowing

you to also selectively edit/update those fields
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TriSys Apex Automatic Browser Tab Focus
When using TriSys Apex, you can automatically display database records when
interacting with a LinkedIn profile.

In order for this display of database records to happen automatically, instead of
logging into TriSys Apex using https://apex.trisys.co.uk please login using

https://your-company-name.trisys.co.uk (where “your-company-name” is the

hyphenated name of your company, which can be found by logging into
https://support.trisys.co.uk with your TriSys credentials).

Add new contact from GMail message

The TriSys browser extension also allows you to import contacts from GMail and
display contact information when you are reading a GMail message and the
sender of the message exists within your TriSys database (this works based on the
senders’ email address, which can match either the personal and/or work email
address of the contact in TriSys).

When reading a message in Gmail, click the TriSys browser extension icon once.

If the sender contact does not exist in TriSys, you can add the contact using “Add
New Contact”, alternatively you can use “Assign to Existing Contact” should you
wish to assign an e-mail address to a contact already on your database, as well
as other contact details automatically extracted from the e-mail message.

< C & maigooglecom L r GEHE @

L Trisys ® Addv § Semngs v
,,,,,, =

Your enquiry with Express Solicitors

*  Stam Susana Hijazi Vicente

Categories

co.uk m"ﬁ Lexcel @

s 0ot @) [l

© Express

The functionality available with the TriSys browser extension for Gmail is identical
to that which is available for Linkedin.
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